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CWS/CMS Training Module Conventions 

Module Purpose and Organization 

This student guide is business process oriented. So, certain sections, notebooks, and pages may be skipped in a specific module and 

presented later when they are relevant to a process. 

This module introduces you to the CWS/CMS tools required to perform the functions of a Supervisor/Manager. 

This module contains the following: 

 Skill building exercises to be used in conjunction with the Scenario Manager application 

 M15_S01 Supervisor Manager – (Part 1) Create a Staff Person.arc 

 M15_S02 Supervisor Manager – (Part 2) Approvals.arc 

 M15_S03 Supervisor Manager – (Part 3) Approvals.arc 

 M15_S04 Supervisor Manager – (Part 4) DOJ Grievance.arc  

 M15_S05 Supervisor Manager – (Part 5) Secondary Assignment.arc 

 M15_S06 Supervisor Manager – (Part 6) Suspended Case.arc 

 M15_S07 Supervisor Manager – (Part 7) Safety Alert.arc 

 A list of objectives for the module 

 A summary of the module. 

 

 

 

 

Disclaimer: The dates presented in this student guide and in the accompanying screen shots may need to be adjusted 

at the user’s discretion to avoid conflicting with dates in scenario manager. 
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Skill Building Exercise: Supervisor/Manager 

SKILL BUILDING EXERCISE 

Scenario Manager File: M15_S01 Create a Staff Person (Part 1)     User ID = DEKKEGB 

              Password = $Bud1bud 

The Resource Management Application 

You are the supervisor of the Emergency Response (ER) Unit of the Sacramento Children’s Protective Services (CPS) Office. There 

are three social worker staff and one Public Health Nurse in your unit. Today, Melissa P has been assigned to your unit as a social 

worker. You, as the supervisor will create a new staff person notebook in the Resource Management application, allowing Melissa P 

access to the CWS/CMS application. 

Melissa P’s start date is 12/01/2008. Her telephone number will be (916) 000-8832. Melissa P speaks English and Spanish. Her 

specialties include experience in After Hours Emergency Response, Dependency Investigation, Emergency Response, and Family 

Maintenance/Court. 

Melissa P will also be assigned a caseload. We will reassign a caseload from you, the supervisor, to Melissa P. 

 

Caseload Application/Client Services Application 

On 12/05/2008, Melissa P was assigned the Cecilia C referral. She is requesting approval of an immediate response to the referral. We 

will walk through the steps of approving a determine response. 

After a thorough investigation of the Cecilia C referral, Melissa P is asking for approval to close the Cecilia C referral. We will walk 

through steps of Client Disposition for both children in this referral. 
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Supervisor/Manager 

Introduction 

This module will walk you through performing office administrative tasks that are typically done by supervisors or managers. 

Objectives 

After completing this module, you will be able to do the following with little or no assistance: 

 Create a new Staff Person 

 Assign a Caseload 

 Record DOJ Grievance Information 

 Make Secondary Assignment 

 Review Approval Requests 

 Suspend Case 

 Record Safety Alert 
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Starting the Resource Management Application 

The first step toward entering staff information is to start the CWS/CMS Control Panel. To start the CWS/CMS Control Panel and the 

Resource Management application, follow these steps: 

1. From the Windows desktop, double click the CWS/CMS icon 

      

           Figure - SM_001 
 

2. In the CWS/CMS Control Panel logon window, (A) verify your User ID, (B) type your password, and (C) click the OK button. 

 

 

   

   
           Figure - SM_002 

 

3. From the CWS/CMS Control Panel, (D) click the Resource Management application icon. 

       

       

 

 

           Figure - SM_003

D 

A 

B 

C 

D 
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Opening an Existing CWS Office  

1. (A) Click on the County Organization Section (green button). (B) Click on the Open Existing Office notebook to open the 

existing CWS office. 

          

          Figure - SM_004  
 

2. (C) Select your county and (D) click OK. 

          

          Figure - SM_005 

 
     

 

A 

D 

C 

B 

This screen shot will only 
appear in Production.  
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Opening an Existing CWS Office (continued) 

3. (A) Highlight the Existing Office in the Open this CWS Office grid, and (B) click OK. 

          

          Figure - SM_006 

A 

B 
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Create a Staff Person 

1. Once the Office notebook appears, (A) click the “+” Create New Staff Person. In the For this CWS Office grid, make sure the 

office is highlighted and (B) click OK. 

      

      Figure - SM_007  
              Figure - SM_008 

A 

B 
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Create a Staff Person (continued) 

ID Page 

1. Complete all mandatory (yellow) and known fields on the ID page of the Staff Person notebook. 

 

       Figure - SM_009 
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Create a Staff Person (continued) 

Specialties Page 

1. (A) Click on the Specialties page tab. (B) Click the “+” in the Language grid. (C) Select the language(s) the staff person speaks, 

and (D) click OK. (E) Click the “+” in the Functional Specialty grid. (F) Select the staff person’s Functional Specialties and (G) 

click OK. 

 

       Figure - SM_010  

                                                                      Figure - SM_ 011         

B 

A 

C 

D 
E

F 

G
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NOTE:  The Caseload page tab will automatically populate from the assignment. 

Create a Staff Person (continued) 

Logon Page 

1. (A) Click the Logon page tab. (B) Click the “+” in the Logon Information grid. (C) Select the Domain. (D) Enter the Password 

and (E) click OK. When the Logon Configuration dialog box appears, (F) click OK. 

           

           Figure - SM_ 012 

 

 

 

                                                                                                                            

 

E 

D 

User Ids: 
The CWS/CMS 
application will create a 
Staff Person Logon and 
record the Domain and 
Password. 

A 

B 

C 

F

Password: 

Passwords are case sensitive and 
must contain at least one uppercase 
letter (A–Z) and/or at least one special 
symbol (#, @, $), and at least one 
lowercase letter (a-z), and at least one 
number (0-9). No other characters are 
allowed. 



 

Rev: 01/2018           Supervisor/Manager Student 
Guide 

15  

  Figure – SM_013 

 

Create a Staff Person (continued) 

Staff Rights Page 

Authorities and Privileges are assigned to every new staff person on the Staff Rights page of the Staff Person notebook in the 

Resource Management application. The Authorities and Privileges given to a user, along with the types of referral and case 

assignments, determine exactly what applications, folders, and notebooks that staff person can access, and what functions within each 

can be performed. 

1. (A) Click the Staff Rights page tab. (B) Click the “+” in the Staff Rights grid to enter the staff person’s privileges and 

authorities. Click the “+” for each privilege and authority needed. (C) Select the Level of Authority, (D) Category, (E) and 

Privilege. 

                    

          Figure - SM_014 Figure – SM_015  

D 
E 

Privilege: 
You can only add 
privileges to staff that 
have a lower level of 
authority than yours.   

Refer to Resource 
Management Module for 
detailed Category, 
Privilege, and Level of 
Authority information. 

A 

B 

C 

This is the 
privilege that 
Probation workers 
are assigned. 
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NOTE: When a staff person is transferred to another office the logon ID transfers with the worker. Within the Transfer Staff dialog 

box a new domain must be selected to which the login ID will transfer. 

Create an Assignment 

Staff Authorities are different from Authorities and Privileges as we just completed in the Staff Person Notebook. Staff authorities 

define a staff person’s role in the management of caseloads within a unit (e.g., Approval and Assignment/Transfer Authority). They 

are assigned on the Staff Authority page of the Assignment Unit notebook. 

1. (A) Click on the Open Assignment Unit notebook. Once the Assignment Unit Open box appears, (B) highlight CPS office and 

(C) click OK. 
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          Figure - SM_016 

Create an Assignment (continued) 

2. (A) Click on the Staff Authority page. 

A 

B 

C
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            Figure - SM_017 

3. (B) Click the “+” in the Staff Authority grid. (C) Scroll through the Staff Person drop-down menu and choose the staff person. 

      

       

 

 

 

 

 

 

 

           Figure - SM_018 

Create an Assignment (continued) 

      (D) Choose the authority level for the new staff person. 

A 

B 

C 
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       Figure - SM_019 

Create an Assignment (continued) 

4. (E) Click the Caseload page tab. (F) Click the “+” in the Caseload grid. (G) Enter the Number/Name of the caseload and (H) 

the Start Date. 

D 
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           Figure - SM_020 

 

Reassign a Caseload 

Reassign a caseload from the Assignment Unit supervisor to the new staff person. 

H 

E 

F 

G 
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1.  From the Action drop-down menu (A) select Reassign Caseload. 

          

          Figure - SM_021

A 



 

Rev: 01/2018           Supervisor/Manager Student 
Guide 

22  

Reassign a Caseload (continued) 

2. Complete the Reassign Caseload dialog box to indicate whom the caseload is being assigned from (you the supervisor). 

3. In the From Staff Person drop-down menu (A) choose the office. (B) In the Staff Person drop-down menu choose the 

supervisor. (C) Select the caseload that is being reassigned. 

         

          Figure - SM_022 

  

C 

A 

B 
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Reassign a Caseload (continued) 

4. In the Staff Person drop-down menu, (D) choose the staff person. (E) Click the Add button. Once the Caseload transfers over 

(F) Click OK. 

       

          Figure - SM_023 

 

 

 

 

                                                                                                      Figure – SM_024 

E 

D 

F 
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Reassign a Caseload (continued) 

5. From the File drop-down menu, select (G) Save to Database and (H) click Continue Working. 

          

          Figure - SM_025 

 

                                                                                                                                       Figure - SM_026 

6. Close the Resource Management Application by (I) clicking on the X. 

    

   Figure _ SM_027 

G 

I 

H 
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Caseload Application  

Supervisors use the Caseload application to view the entire assignment unit’s collection of caseloads. From the Caseload application, a 

supervisor has one central location to view all pending approval requests. A supervisor can also assign cases and referrals to a staff 

person or reassign them as circumstances require. 

1. From the Control Panel (A) Open the Caseload Application 

 

 

 

 

. 

      Figure – SM_028 

The Bulletins Notebook 

2. (A) The Bulletins notebook displayed statewide messages that were created by users with the Bulletin Administrator privilege.  

Bulletins in the Caseload application are no longer updated. 

       

 

 

 

 

 
        Figure – SM_029 

  

A 

A 



 

Rev: 01/2018           Supervisor/Manager Student 
Guide 

26  

Caseload Application (continued) 

The Supervisor Notebook 

Supervisors use the Supervisor notebook to view caseload assignments and approval requests. CWS/CMS creates and maintains a 

Supervisor notebook for each unit supervisor. You must have staff authority as set up in the Resource Management application to 

open the Supervisor notebook. 

1. To open the Supervisor notebook, (A) click the Open Existing Supervisor notebook icon. 

     

Supervisor notebook: 

The entire Supervisor notebook is 
read-only. 

A 

Non-CWD Cases: 

Rows for Non-CWD cases will 
display pink. 
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     Figure – SM_030 

Figure – CL_011 
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Caseload Application (continued) 

The Supervisor Notebook - Summary Page 

1. Supervisors use this page to view the distribution of cases and referrals among caseloads over which they have staff authority. 

The Summary grid (A) lists each caseload in the unit(s) over which the supervisor has staff authority, along with the assigned 

staff person, ceiling, weight at logon, and combined total of cases and referrals. The Service Components grid (B) lists each 

service component in the caseload selected in the Summary grid, and the total number of cases and referrals having that 

component. 

        

        Figure – SM_031 

Total Cases/Referrals: 

This combined total represents the 
number of assignments for the given 
caseload. 

A 

B 
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Caseload Application (continued) 

The Supervisor Notebook - Requested Actions Page 

1. Supervisors use this page to view approval requests for the referrals and cases in their assignment unit. Requested actions that 

have been approved or rejected will drop off this list immediately. 

          
        
          Figure – SM_032 

Non-CWD Cases: 

Rows for Non-CWD cases 
will display pink. 
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Caseload Application (continued) 

The Caseload Notebook 

Use the Caseload notebook to view information about the cases and referrals in a specific caseload. It also provides an overview of 

pending and recent approval actions taken for the cases and referrals in a caseload. CWS/CMS creates and maintains the Caseload 

notebook automatically. 

1. To open the Caseload notebook, (A) click the Open Existing Caseload icon. (B) In the Open this Caseload dialog box, select 

the caseload to be opened and (C) click the OK button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
        Figure – SM_033 

  
 
 
 

A 

B 

B 

B 

C 

Non-CWD Cases: 

Rows for Non-CWD cases 
will display pink. 
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          Figure – SM_034 
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Caseload Application (continued) 

The Caseload Notebook - Summary Page 

1. Use this page to view general information about the cases and referrals in the caseload you selected to open. The Assigned 

Cases/Referrals grid lists the name of the case or referral, the type of assignment, the assignment date, the case service 

component, and the responsibility description of active assignments for each case or referral in the caseload. 

          

          Figure – SM_035 

Assigned 
Cases/Referrals 
Grid: 

If you double click a 
row in this grid, the 
Client Services 
application will start 
and open the folder 
for that case or 
referral. 

Non-CWD Cases: 

Rows for Non-CWD cases 
will display pink. 
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Caseload Application (continued) 

The Caseload Notebook - Approval Actions Page 

1. Use this page to view the current status of each approval request for the cases and referrals in a caseload. The Approval 

Actions grid lists the submitted date, the approval type, approval status, and the case or referral name for each approval action 

taken in the caseload. The Case/Referral ID column will populate for all approval actions with the exception of Case Plan and 

Court Report approval requests. This grid is automatically filled by CWS/CMS as staff persons submit documents and actions 

for approval, and it is updated when responded to by supervisors. Approval actions that have been approved or rejected will 

drop off this list after two weeks. 

           

           Figure – SM_036 
 

From the File drop-down menu, select Exit. Close the Control Panel.  

Approval Requests: 

Items will disappear from the 
supervisor’s Requested 
Actions page as they are 
approved or rejected. Those 
on the Approval Actions 
page of individual caseloads 
will remain for two weeks. 
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Approvals 

A user electronically submits requests for a supervisor to approve a document or an action (e.g., a case plan or a response level for a 

referral). A supervisor may electronically take action on the request by indicating it is approved, rejected, pending higher approval, or 

returned for required modification. 

The CWS/CMS business rules require some documents and actions to be approved by a Unit Supervisor. County policy may require 

other documents and actions to be approved by a Unit Supervisor. 

The following approvals are mandatory in CWS/CMS: 

In a referral: 

 Referral Determine Response - if Evaluate Out 

 Client Disposition 

In a Case: 

 Case Plan 

 End Case 

The following approvals are optional (county policy): 

 Referral Determine Response - if not Evaluate Out 

 Placement 

 Ongoing Payment Request 

 Incidental Payment Request 

 Court Report (although to satisfy a Court Report System-generated Reminder, a Court Report must be approved.) 

 Transfer Request 
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Approvals (continued) 

Scenario Manager File: M15_S02 Approvals (Part 2)      User ID = DEKKEGB  

             Password = $Bud1bud 

Approvals in a Referral 

The following are step-by-step instructions for a supervisor to respond to staff requests for approvals of response time to a referral 

starting in the Caseload Application, and continuing into Client Services, for Client Disposition and Case Plan approvals. 

1. From the Control Panel open the Caseload Application.(A) Click on the Caseload Notebook. 

          

          Figure – SM_037 
 

2. (B) Highlight desired caseload and (C) click OK. 

          
         

A 

B 

C 
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        Figure – SM_038 

Approvals (continued) 

3. When the Summary page appears (D) highlight desired referral and double click. 

           

            Figure – SM_039  

4. The Client Services application automatically opens. (E) Click Yes to open referral. 

   

         
 
 
 
    
           Figure – SM_040  

– SM_041     Above figure ONLY appears in the live application   Figure 

D 

E 
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Approvals (continued) 

Approvals in a Referral - Determine Response 

1. Once the referral is in focus, (A) click on the Action drop-down menu and (B) select Determine Response. 

 

Figure – SM_042 

A 

B 
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Approvals (continued) 

2. Review your staff’s decisions and (C) select the Approval button. 

 
 
Figure – SM_043 

  

C 
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Approvals (continued) 

3. In the Approval Detail dialog box, (D) use the Approval Status drop-down list to select Approved. (E) Verify Action Date and 

(F) click OK which will then automatically return you to the referral. 

 

Figure – SM_044 

  

D 

E 

F 
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Approvals (continued)  

Approvals in a Referral – Client Disposition 

Use the Client Disposition command to approve the closing of the referral by promoting it to a case or to end Child Welfare Services 

involvement. 

1. To approve the client disposition, (A) click the Action drop-down menu (B) select Client Disposition. 

       

      Figure – SM_045     

A 

B 
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Approvals (continued)  

2.  (C) In the Select this Client grid, highlight one child client and (D) click OK. 

             

              Figure – SM_046 

  

C 

D
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Approvals (continued) 

3. (A) The Decision Rationale area is used to explain why the referral is closing, or promoting. This area is optional. (B) Click the 

Approval button. 

          

          Figure – SM_047 

  

A 

B 
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Approvals (continued) 

4. In the Approval Status drop list (A) select Approved from the drop-down menu. 

          

          Figure – SM_048 

  

A 
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Approvals (continued) 

5.  (B) Verify date in the Action Date field and (C) click OK. 

          

          Figure – SM_049 

  

B 

C 



 

Rev: 01/2018           Supervisor/Manager Student 
Guide 

45  

Approvals (continued) 

6. The system will automatically return to the Select Notebook. Repeat steps 2 through 5 for all child victims. Once all children 

have been approved (D) click the Cancel button. 

           

           Figure – SM_050 

  

D 
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Approvals (continued) 

The system automatically takes you back to your referral. Close the Caseload application. Use the File drop-down menu, select save 

to database and click Continue Working. 

 

Figure – SM_051 
 



 

Rev: 01/2018           Supervisor/Manager Student 
Guide 

47  

Approvals (continued) 

Approvals in a Case 

The following are step-by-step instructions on how to approve a Case Plan and also how to End a Case, which are both mandatory 

approvals in the CWS/CMS application. 

Case Plan Approval Requirements: 

 Both a primary language and primary ethnicity must be entered for each case plan focus child (in the Client notebook, ID page) 

 The Child Welfare Services Case Plan document must be created.  (Verify by opening the Existing Case Plan Document 

notebook) 

 There must be at least one service objective entered for at least one of the case plan participants (in the Case Plan notebook, 

Service Objectives page) 

 All mandatory fields must be completed, if not, after saving to the database, CWS/CMS will generate an error message 

indicating a missing mandatory field. Once OK is selected in the error message dialog box, the user will be brought to the page 

where the mandatory field is missing 

 The Case Plan notebook must be in focus. If not, use the Open Existing Case Plan notebook to bring it into focus 

 

When a case plan is pending approval, the case plan (with the exception of the ID page) and all documents are read-only.  Therefore it 

is recommended staff submit a hard copy of the case plan documents to the supervisor who will approve it before requesting an 

electronic approval. 

To approve a case plan, the Case Plan notebook must be in focus. You can open a case from the Caseload application by following the 

steps previously mentioned in Approvals Referral or by opening the Client Services application. For these instructions, we will be in 

the Client Services application. 
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Approvals (continued) 

Scenario Manager File: M15_S03 Approvals (Part 3)      User ID = DEKKEGB  

             Password = $Bud1bud 

Case Plan Approval 

1. Log on to the CWS/CMS Application. (A) Open Client Services. 

 

          Figure – SM_052 
 

2. From Search, in the Menu Bar, (B) highlight Start Search. (C) In the Search screen verify the Search Type is Client. (D) Insert 

clients first and last names in the appropriate fields and (E) click OK. 

          

       Figure – SM_053                                                     

 

 

 

 

 

B 

Figure - SM_054 
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E
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Approvals (continued) 

3. (F) Highlight the case you would like to open and double click. 

       

     Figure - SM_055                                                                                                                                                                                                                                                 

F 
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Approvals (continued) 

4. From the Client Abstract look through the pages to verify this is the client you are looking for. 

  

 Figure – SM_056 
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Approvals (continued) 

5. From the Associated drop-down Menu (G) highlight Open Associated Case. 

 

  

   

G 

Figure – SM_057 
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Approvals (continued) 

6. When Open Associated Case box appears, (H) click OK. 

  

 Figure – SM_058 

  

H 
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Approvals (continued) 

7. The case will automatically open to the Case Management Section (green button) ID page. (I) Click on Open Existing Case 

Plan notebook. 

       

       Figure – SM_059  

 

 

 

 

                                                                  Figure – SM_060 

Non-CWD Cases: 
Non-CWD Cases will appear with a pink 
Non-CWD Case Info label. 

I 
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Approvals (continued) 

8. (J) Select the In Progress Case Plan and (K) click OK. 

       

       Figure – SM_061 

J 

K 
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Approvals (continued) 

9. (L) Review the Case Plan and verify Review and Signed Date fields. 

       

       Figure – SM_062 

L 
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Approvals (continued) 

10.  (M) From the Action drop-down menu (N) select Approval. 

 

       Figure – SM_063 

M 

N 
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Approvals (continued) 

11.  In the Approval Detail dialog box (O) fill in the Action Date. Be sure and check the date in the Action Date field. The starting 

date of the case plan is effective the date you approve it. (P) Select Approved in the Approval Status field. (Q) Click the OK 

button. 

       

       Figure – SM_064 

  

O 

P 

Q 
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Approvals (continued) 

     12. The system will automatically return you to the case. (R) Click File, (S) Save to Database and exit. 

 

Figure – SM_065 

R 

S 
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Reopen a Closed Referral to Record a DOJ Grievance 

Introduction 

Users with Closed Case/Referral Update privilege are able to update five areas in closed referrals/cases: The five areas are Client 

notebook, Screener Narrative document, Cross Reports, Investigation Narrative document, and Grievance fields. 

Users with Closed Case/Referral Update privilege are able to reopen an evaluated out referral. In situations where a referral has been 

closed with a Client Disposition of ‘Open New Case' for a specific child, users with Closed Case/Referral Update privilege and access 

to the closed referral have the ability to update the entire Allegation Notebook (including the ability to create a new allegation) for that 

child only. 

The DOJ Grievance 

The DOJ (Department of Justice) Grievance Request grid on the Referral ID page allows the end user to record multiple grievance 

requests. 

When updating Allegation Conclusions, users are able to indicate if the update was due to a grievance and Allegation Occurrence 

Dates are editable when the Edit Allegation Conclusion is selected. 

An alleged perpetrator can challenge the allegations and conclusions in a referral by filing a DOJ Grievance. Users with Closed 

Case/Referral Update privilege are able to document the requests for a grievance review, along with the date of the request, the alleged 

perpetrator who filed the request, the date of the review, and the outcome. 
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Skill Building Exercise: Recording a DOJ Grievance 

Scenario Manager File: M15_S04 DOJ Grievance (Part 4)      User ID = DEKKEGB 

                         Password = $Bud1bud 

Background Information 

 

In December 2008, social worker Melissa P received, and investigated, a referral on the Barbara C family. There were allegations of 

physical abuse and the referral was closed with a substantiated disposition and a case was open for the minor. 

On December 10, 2008, the Children’s Protective Services Office received a SOC 834, stating that Jerry C disagreed with the 

substantiated physical abuse allegations against him and had filed a request for a DOJ Grievance Hearing. 

On January 8, 2009 the Department received word that after a thorough investigation the Court has found that allegations against Jerry 

C should be recorded as unfounded and his name removed from Department of Justice records. 
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Skill Building Exercise: Recording a DOJ Grievance (continued) 

Locate the Referral 

The following steps will demonstrate how to open a closed referral to record DOJ Grievance information. 

1. Log on to the CWS/CMS Application. (A) Open Client Services. 

  

 

       Figure – SM_066 

 

2. (B) Click on the Search drop-down menu and (C) Start Search. 

  

      Figure – SM_067 

  

B 

A 

C 
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Skill Building Exercise: Recording a DOJ Grievance (continued) 

Perform a Client Search 

3. (A) Fill in the family name and a family member’s first name. (B) Click OK When searching for a client, the least restrictive 

information is best. If you receive “too many hits” then it’s a good time to add more criteria, such as; approximate age, 

gender. 

       

        

 

Figure – SM_068 

A 

B 
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Skill Building Exercise: Recording a DOJ Grievance (continued) 

4. Once the Search Results appear (A) highlight the referral and double click your mouse to open the client abstract. 

       

   

  

A 

Figure – SM_069 
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Skill Building Exercise: Recording a DOJ Grievance (continued) 

Perform a Client Search – Review Client Abstract 

5. Review the page tabs to verify you have the correct referral. 

        

       Figure – SM_070 
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Skill Building Exercise: Recording a DOJ Grievance (continued) 

Open Associated Referral 

6. (A) Click on the Associated drop-down menu and highlight Open Associated Referrals. 

        

        Figure – SM_071 

A 
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Skill Building Exercise: Recording a DOJ Grievance (continued) 

7. Once the Associated Referral screen appears (B) click OK. 

        

       Figure – SM_072  
 

 
             Figure – SM_073 

 

                     Above figure ONLY appears in the live application. 

        
 
 

  

B 
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Recording the DOJ Grievance Information  

Referral ID page 

1.  (A) Click the “+” of the DOJ Grievance Request grid. 

       

A 
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       Figure – SM_074 

Recording the DOJ Grievance Information (continued) 

2.  (B) Enter the Request Date. (C) In the Filed By drop-down menu choose the person requesting the grievance. 

       

Figure – SM_075 

 

B 

C 
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Recording the DOJ Grievance Information (continued) 

Allegation Notebook 

1. To record the results of a DOJ Grievance (A) Open the Allegation Notebook. (B) Highlight the allegation and (C) Click OK. 

       

       Figure – SM_076 

A 

B 

C 
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Recording the DOJ Grievance Information (continued) 

Allegation Notebook – Conclusion page 

1. (A) Open the Conclusion page. 

       

       Figure – SM_077 

 

A 
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Recording the DOJ Grievance Information (continued) 

Edit Allegation Conclusion 

1. (A) From the Action drop-down menu, (B) select Edit Allegation Conclusion. 

       

       Figure – SM_078 

 

A 

B 
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Recording the DOJ Grievance Information (continued) 

1 (A) The dialog box will ask “Is the allegation conclusion change due to a DOJ Grievance Review?” (B) Click Yes. 

 

Figure – SM_079 

A 

B 
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Recording the DOJ Grievance Information (continued) 

2.   (A) Choose Unfounded in the Allegation Conclusion drop-down menu. Complete all mandatory fields, and (B) Choose the Yes 

radio button in the Allegation Conclusion modified as a result of DOJ Grievance field. 

       

       Figure – SM_080 

 

HINT: 

Make sure the 
correct radio 
button is selected 
to indicate if the 
conclusion was 
modified as a 
result of a DOJ 
Grievance. 

 

 

A 

B 
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Recording the DOJ Grievance Information (continued) 

Update DOJ Grievance Outcome 

1. (A) Click the Referral Notebook icon. (B) Use the scroll bar to reach the DOJ Grievance Request grid on the ID page. (C) 

Record Resolution Date and (D) Outcome. Complete by saving to database. 

 

Figure – SM_081 
 

NOTE:  BE SURE TO REPORT THE GRIEVANCE OUTCOME TO DOJ PER YOUR COUNTIES PROCEDURES. 

A  

B 

C 
D 
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From the File drop-down menu, select Save to Database and Exit. 

 

Skill Building Exercise: Make a Secondary Assignment 

Scenario Manager File: M15_S05 Secondary Assignment (Part 5)  User ID = DEKKEGB 

 Password = $Bud1bud 

Background Information 

 

The Following Instructions Are To Aid A Supervisor The Day To Day Use Of The CWS/CMS Application. Responsibilities of 

a supervisor may vary from county to county, however.  

Secondary Assignment/Transfer Assignment 

Use the Transfer Assignment command to transfer a primary or secondary assignment (responsibility) for a case or referral to another 

caseload in your unit, or in another unit, office, or county. This is especially useful when transferring assignments for more than one 

case or referral. This enables a user to transfer the assignment(s) without entering Client Services and retrieving the case(s) and or 

referral(s) from the database. 

When a single case or referral needs Transfer Assignment/Secondary Assignment, a supervisor can follow the steps in opening the 

existing case in Client Services, opening the Assignment page, and proceed with making assignment. 

 

SKILL BUILDING EXERCISE 

Your new social worker, Melissa P, now has a caseload. You would like the Public Health Nurse to have secondary assignment to Ms. 

P’ case. 
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Make a Secondary Assignment  

To make a secondary assignment, start the CWS/CMS Control Panel. To start the CWS/CMS Control Panel and the Caseload 

application, follow these steps:  

1. From the Windows desktop, double-click the CWS/CMS icon. 

 

        Figure – SM_082 

 

2. In the CWS/CMS Control Panel logon window, (A) verify your User ID, (B) type your password, and (C) click the OK button. 

 

 

 

 

3. From the CWS/CMS Control Panel, (A) click the Caseload application icon. 

 

       Figure – SM_084 

 

A 

C 

B 

   Figure -  SM_083 

A 
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Make a Secondary Assignment (continued) 

4. (A) Click on the Opening Existing Caseload folder. (B) Highlight the appropriate Caseload and (C) click OK. 

      

     Figure – SM_085 

  

A 

B 

C 



 

Rev: 01/2018           Supervisor/Manager Student 
Guide 

78  

Make a Secondary Assignment (continued) 

5. The selected Caseload Summary page will open. (A) Highlight the case. 

 

       Figure – SM_086 
 

6. (B) From the Action drop-down menu, (C) select Make Assignment. 

 

      Figure – SM_087 

A 

B 

C 



 

Rev: 01/2018           Supervisor/Manager Student 
Guide 

79  

Make a Secondary Assignment (continued) 

7. The Make Assignment dialog box will open.  In the Responsibility frame (A) select the Secondary radio button. Assignment 

Destination section defaults to CWS Staff. If you are working in an ICPC case, select the Out Of State radio button. Details 

Start Date automatically populates with current date. 

 

       Figure – SM_088 

  

A 
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Make a Secondary Assignment (continued) 

8.  (B) Scroll through the Role Type drop-down menu and highlight appropriate secondary assignment. 

 

       Figure – SM_089 

  

B 
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Make a Secondary Assignment (continued) 

9. In the CWS Staff section, Select Case/Referral Unit, (C) select CPS in the dropdown menu. 

 

       Figure – SM_090 

  

C 
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Make a Secondary Assignment (continued) 

10.  (D) Choose the Caseload from the Caseload drop-down menu. (E) In the Case/Referral drop-down menu choose the name of 

the Case/Referral. 

 

      Figure – SM_091 

  

D

E 
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Make a Secondary Assignment (continued) 

11.  (F) Select desired County from the County (or State of California) drop-down list. (G) Select the desired office from the 

CWS Office drop-down list. (H) Select the Unit the case will be assigned to. 

 

       Figure – SM_092 

  

F 
G 

H 
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Make a Secondary Assignment (continued) 

12.  (I) Choose the Caseload from the Caseload drop-down menu. The Staff Person, phone number, and extension will 

automatically populate. If you need to give secondary assignment of another case or referral, click the Apply button, and 

follow the previous steps. If this is the only case to be given secondary assignment (J) click OK and the system will return you 

to the caseload. 

 

      Figure – SM_093 

 

I 
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Caseload Reports 

Caseload reports present data for a specific caseload or assignment unit. These reports include calendars of court hearings, caseload 

reminders, due dates to update cases in a caseload, and the visits and contacts scheduled for a caseload. 

1. To generate a caseload report, open the Caseload application, (A) open the Caseload notebook. 

  

        Figure – SM_094 
 

2. (B) Select a caseload and (C) click OK. 
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B 
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       Figure – SM_095 

Caseload Reports (continued) 

3. (D) From the File drop-down menu select Print Report. 

 

       Figure – SM_096 
 

4. (E) Select the report to be generated and (F) click the Print Preview button. 

 

       Figure – SM_097 
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F 
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Caseload Reports (continued) 

5.  (G) Select Caseload to be reported and (H) click OK. 

 

      Figure – SM_098 
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Caseload Reports (continued) 

6. The report will automatically populate. When Microsoft Word has generated the document, (A) review information, (B) print 

or Save, if applicable, and (C) close. 

       

            Figure – SM_099 

 

Close the Caseload application. From the File drop-down menu, select Save to Database and click Continue Working. 

A 

B 
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Skill Building Exercise: Suspended Case 

Skill Building Exercise: Suspended Case 

Scenario Manager File: M15_S06 Suspended Case (Part 6) User ID = DEKKEGB 

 Password = $Bud1bud 

Background Information 

You are supervisor, Gerrie D. You have just received word that Kimberly F’s case is being assigned to your unit.  Kimberly was 

previously an open case in your unit, but closed with the Probation Department taking over case management responsibility. We will 

complete the steps for recording a Suspended Case. 

1. (A) Open Client Services. 

 

       Figure – SM_100 

 

2. Search the database for the client by (A) clicking on the Search drop-down menu and (B) highlighting Start Search. 

 

      Figure – SM_101 

 

A 

B 

A 
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Suspended Case (A) 

3. (C) Insert the last and first names of the client and make sure there is a red check mark next to each (D) Click OK. 

 

       
  

C 

D 

Figure – SM_102 
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Suspended Case (continued) 

4. The system will now search state wide to find Kimberly F. Once the Search Results appear, (E) highlight Kimberly F case 

double click the mouse. 

 

  Figure – SM_103 

  

E 
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Suspended Case (continued) 

5. The Client Abstract will come into focus. Review the page tabs to verify this is the client you are searching for. 

           

           Figure – SM_104 
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Suspended Case (continued) 

6.  (A) From the Associated drop-down menu, (B) highlight Open Associated Cases. 

    

A 

B 
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          Figure – SM_105 

Suspended Case (continued) 

7.  (A) Highlight the case to open from the Open this Associated Case grid and (B) click OK. 

    

           Figure – SM_106 

  

B 
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Suspended Case (continued) 

The closed case will then be displayed. 

 

Figure – SM_107 
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Suspended Case (continued) 

8. Instruction For The Live Application: (A) Click on the Assignment page tab. (B) Click the History button (C) When the 

Retrieve Historical Information box appears check the All radio button (D) and click OK. For Use With Scenario Manager, 

Skip To Step 9. 

 

      Figure – SM_108 
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Suspended Case (continued) 

9.  (A) Click on the Action drop-down menu and (B) choose Reopen Closed Case. 

    

B 

A 
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           Figure – SM_109 

Suspended Case (continued) 

10. The Reopen/Suspend Case dialog box will appear. (A) Click the Yes radio button that the case is being reopened due to an 

earlier suspension period. (B) In the Suspension Details section, choose the Reason for Suspension from the drop-down menu. 

 

Figure – SM_110 
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Suspended Case (continued) 

11. (C) The Suspension Start and End Date fields will automatically default to the day the case was closed and the current date.  If 

these dates are not correct, you can insert correct dates.  (D) Select the appropriate radio button in the Case Status Following 

the Suspension Period field (E) Select the appropriate Service Component from the Service Component Following the 

Suspension Period drop-down list. (F) Complete the Suspension Period Assignment grid with: CWS Office, Unit, and 

Caseload. (G) Complete the Primary Assignment grid with current CWS Office, Unit, and Caseload.  (H) Click OK. 

  

        Figure – SM_111 
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Suspended Case (continued) 

12. The case is now reopened. (A) On the ID page, the Case Suspension grid, on the bottom of the page, has automatically been 

completed. 
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           Figure – SM_112    

             

Suspended Case (continued) 

13. To complete this Suspended Case process, from the (B) File drop-down menu choose (C) Save to Database. 

A 



 

Rev: 01/2018           Supervisor/Manager Student 
Guide 

102  

     

             Figure – SM_113 
 

Suspended Case (continued) 

Choose Exit CWS/CMS to save your work and exit the application. If you choose the Cancel button none of your work will be saved. 

B 

C 
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Figure – SM_114 
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Skill Building Exercise:  Safety Alert 

Safety Alert 

Scenario Manager File: M15_S07 Safety Alert (Part 7) User ID = DEKKEGB 

 Password = $Bud1bud 

Background Information 

On 12/08/2008, Kristen F, the Public Health Nurse working in your unit, informs you that while visiting the Jessica S home, the father 

James S became very upset.  James S is questioning why a Public Health Nurse is allowed in his home, telling him how to be a parent, 

and if anyone from Children’s Protective Services steps foot on his property they better watch it.  He informed the Nurse that he has 

four trained pit bulls in his back yard, and he won’t hesitate to let them loose if Kristen F returns. 

Kristen F is very concerned about anyone from the Department approaching the S home.  You, as the supervisor will now follow the 

steps, on the following pages, to mark James S as a Safety Alert. 
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Safety Alert (continued) 

1. After logging on to the CWS/CMS application, (A) open the Caseload application. 

     

     Figure - SM_115 

2. (B) Open the Caseload notebook. 

      

     Figure – SM_116 
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Safety Alert (continued) 

3. (C) Open the FR4 Caseload of the Public Health Nurse by highlighting the row. (D) Click OK. 

     

    Figure – SM_117 
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Safety Alert (continued) 

4.  (E) Open the Jessica S referral by highlighting the row and double clicking the mouse. 

       

      Figure – SM_118 
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Safety Alert (continued) 

5. (F) Click on the Client Management section (blue button), and (G) click on the Open Existing Client notebook. 

      

     Figure – SM_119 
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Safety Alert (continued) 

6. (H) Choose James S Sr. from the Open this Client grid and (I) click OK. 

   

Figure – SM_120 
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Safety Alert (continued) 

7.  (J) Scroll down the page and click the “+” in the Safety Alert Information grid. 

          

          Figure – SM_121 

 

J 
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Safety Alert (continued) 

8. (K) Enter the Activation Date. (L) From the drop-down menu, choose Reason for Safety Alert and (M) in the Explanation text 

box, explain details for Safety Alert. 

       

  Figure – SM_122 
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Safety Alert (continued) 

9. Close Caseload application from previous step 4. In Client Services (N) File and (O) Save to Database, and Exit 

CWS/CMS. 

 

  Figure – SM_123 
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Safety Alert (continued) 

INFORMATION ONLY: Once the referral has been saved to database, any staff opening the referral will see the following red 

text. The red text (Alert) will also appear in the client notebook and all search results. 

 

  Figure – SM_124 
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Helpful Hints 

Reminders 

The CWS/CMS application creates some reminders automatically (e.g., “Report to Mandated Reporter Due”) when certain conditions 

are present (e.g., the Feedback Required box has been checked on the Reporter page of the Referral Information notebook). Those 

reminders are automatically removed if any of the conditions that set the reminder change or if action is taken on a reminder and 

recorded in the proper notebook (e.g., a date is entered in the Feedback Sent field on the Reporter page of the Referral Information 

notebook). 

Supervisors and users can create their own reminders by clicking the “+” under the Open Existing Reminders notebook, and entering a 

reminder with a due date. These reminders can be removed using the Remove button in the Open Notebook dialog box. 

To view reminders, click on the Open Existing Reminders notebook. Every caseload you have opened during your current session 

(have in current work or cache) will display in the top part of the dialog box. Select a caseload and all the reminders in it will display 

in the bottom part of the dialog box. Use the buttons in the dialog box to sort and filter the reminders. 

Reminders for a referral or case can only be viewed in the caseload of the staff person who has the Primary (not Secondary or Read-

Only) Assignment. 

 

Figure – SM_125 
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Helpful Hints (continued) 

Locating a Referral/Case without a name  

You can find and open referrals and cases from the Caseload and Client Services applications. When a referral or case is assigned to a 

caseload in the unit you supervise, you can open it when you are working in the Caseload application. 

When a referral or case is not assigned in the unit you supervise, there are two ways to find and open it in the Client Services 

application. During these instructions you have opened cases/referrals through the Caseload application and the assigned worker, and 

also through the Clients Services application using the search method of locating a case/referral by client name. The following steps 

will show you how to locate a case or referral without a name. 

1. Use the Find Folder command in the File menu if the referral or case is not assigned in the unit you supervise, and you know 

the full Referral Number or Case Number. (Note: This is not the Client Number or the State ID number. It is the number on 

the ID page of the Referral or Case Information notebook.) 

 

 

       Figure – SM_126 

 

 

                                                                                                                        

                                                                                                                        
 
 
 

                                                                                                       Figure – SM_127                                                 
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Helpful Hints (continued) 

2. Use the Start Search command in the Search menu if the referral or case is not assigned in the unit you supervise, and you 

know the name of a client in the case or referral. When you find the client, open his/her Client Abstract from the Search 

Results page. Then, use the commands in the Associated menu to find and open referrals and cases associated with that client. 

This was previously demonstrated in the Suspended Case Section of this module. 

If you don’t know the Referral or Case Number, and don’t know the name of a client in the referral or case, you can search using the 

information you have (e.g. a complete or partial address), a social security number, or a State ID number. 

To narrow a Client Search, if your initial search exceeds the maximum number of hits, add an approximate age. If the approximate age 

is 12 or less, the search range will be plus or minus 2 years. Otherwise it will be plus or minus 5 years. 

To distinguish if a referral or case is open or closed see below: 

The referral or case is closed if there is an End Date (not Projected End Date) on the Summary page of the Referral or Case 

Information notebook. If a case is closed, there may also be a closing summary on the Closure Summary page of the Case 

Information notebook. 
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Helpful Hints (continued) 

If you are viewing summary information for a referral or case on the Referral or Case History page of a Client Abstract notebook, look 

at the End Date column in the Referral History or Case History grid. If the row for the referral or case you are viewing has an (A) end 

date, it is closed. (The referral disposition[s] or closure reason, as well as the name and telephone number of the last staff person with 

the primary assignment to the referral or case, will usually also be on the page.) 

 

A 
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Figure – SM_128 

Helpful Hints (continued) 

Reopen a Closed Case 

The Reopen Closed Case command enables you to reopen a case that was previously approved for closing. A case may have been 

erroneously closed and/or you may want to enter additional data in it, for example: record Suspended Case information. You can open 

a closed case at any time. This was demonstrated in the Suspended Case Section of this module. 

The following pertains to the reopening of a closed case: 

 You must be the supervisor of the staff person who had the last primary assignment in the case or have County Administrator 

authority in the county of the staff person who had the last primary assignment. 

 If the previous assignment is no longer valid (e.g., the staff person is no longer employed) a message will prompt you to create 

a new primary assignment before saving to the database. 

 As of Release 6.8, June 2013, functionality is now available to open a case for a client age nineteen (19) until age twenty-six 

(26) as the focus child of a case. 

Reopen a Closed Referral 

A referral may be reopened if it was erroneously closed or for editing purposes. There are two ways to reopen a closed referral. 

 You can use the Client Disposition function to reopen a referral by modifying the Client Disposition information, if the referral 

has not been pushed to a case, you have access to the referral, and you have Closed Case/Referral Update privilege. 

 You can use the Determine Response function to reopen a referral if it was previously closed with a Decision of Evaluate Out or N/A Secondary 

Report, you have access to the referral, and have Closed Case/Referral Update privilege. Closed referrals with a Decision of N/A Secondary 

Report, and that have a Client Disposition entered cannot be reopened through the Determine Response dialog.
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Helpful Hints (continued) 

Limit Access 

The Limit Access command enables you to impose access restrictions on the referral or case in focus. 

Use this function to restrict access to all clients in the referral or case in focus to staff persons currently assigned to it, their 

supervisor(s), and staff persons with Sealed or Sensitive Person privilege as set up in the Resource Management application. 

You can limit access to a referral or case or return it to non-limited access at any time while the referral or case is open. 

To Limit Access follow the steps below: 

You must have Limit Access authority as set up in the Resource Management application. 

 

       Figure – SM_129 
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Helpful Hints (continued) 

With the referral or case in focus, click on the Limit Access command in the Action menu. Then make a selection in the Limit Access 

dialog box. 

When a Referral or Case is marked as Sensitive, the clients in the referral or case will appear in Search Results. However, unless you 

are staff person with Sensitive Privileges in the county of the client, you will not be able to open their Client Abstract notebooks. 

When a Referral or Case is marked Sealed, the clients in the referral or case will not appear in Search Results unless you are staff 

person with Sealed Privileges in the county of the client. 

 Users must have Adoptions privilege set up in Resource Management in order to open a case they are not assigned to that has 

Adoption Services as an Intervention Reason on the Case ID page. 
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Helpful Hints (continued) 

The Allegation Notebook contains key information from a reporter or a staff person about suspected child mistreatment. 

At least one Allegation notebook is required in order to save a new referral to the database. Create one or more Allegation notebooks, 

based on information from the reporter, when a referral is first created. Add additional allegations, based on information from the 

investigating staff person, at any time while the referral is open. You must conclude each allegation in order to close a referral. 

Change an Alleged Perpetrator 

To change an Alleged Perpetrator, bring the Allegation notebook into focus and use the Update Allegation Perpetrator command in the 

Action menu to enable to Alleged Perpetrator field and Perpetrator Type radio buttons on the ID page of the Allegation notebook.  

NOTE: A history of allegation perpetrators is automatically maintained in the Perpetrator History grid on the ID page of the 

Allegation notebook. 

 

Figure – SM_130                                                                    
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Helpful Hints (continued) 

You must have at least an attempted Contact with a contact purpose of investigate referral to conclude an allegation. 

Change Allegation Conclusion 

To change an Allegation Conclusion, bring the Conclusion page of the Allegation notebook into focus and use the Edit Allegation 

Conclusion command in the Action menu to enable the Allegation Conclusion field. You can then change the conclusion. 

When you change an Allegation Conclusion, the Conclusion Description field on the Conclusion page becomes mandatory. 

A history of conclusions is automatically maintained in the Conclusion History grid on the Conclusion page of the Allegation 

notebook. 

Remove Allegation Entered in Error 

To remove an allegation that has been entered in error, bring the Conclusion page of the Allegation notebook into focus, select the 

Edit Allegation Conclusion command from the Action Menu, and then select the Allegation Conclusion Type “Entered in Error”. 

The allegation and its associated victim will continue to exist on the database until the supervisor approves the client dispositions and 

the referral is closed. Then, the CWS/CMS application system will automatically delete all allegations with the conclusion “Entered in 

Error”. 

To view all key information that has been entered into a referral or case, click on the Start Navigation Tool icon (or access this 

function from the Tools menu) and select the Case/Referral Overview tool. 
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Helpful Hints (continued) 

View Counts 

To use the View Counts command, select the View Counts command in the Action menu, the View Counts dialog box appears. It 

contains a list of each type of notebook and document, and the number of each in current work (cache) in the referral or case in focus. 

You can open a notebook by double clicking on its row. 

 

Figure – SM_131 
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Helpful Hints (continued) 

Reset Password 

In order to reset a user’s password you must have Resource Management privileges. 

1. In the Resource Management application, (A) open the existing office. 

 

       Figure – SM_132 
 

2.  (B) Select County from the drop-down menu and (C) click OK. 

 

Figure – SM_133 

  

A 

B 

C 



 

Rev: 01/2018           Supervisor/Manager Student 
Guide 

126  

Reset Password (Continued) 

3. (D) Choose the appropriate office. (E) Click OK. 

 

Figure – SM_134 
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Helpful Hints (continued) 

4. (F) Open existing Staff Person needing the password reset. 

 

Figure – SM_135 
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Helpful Hints (continued) 

5. (G) Highlight the correct staff person and (H) click OK. 

 

Figure – SM_136 

6. (I) Select the Logon Page tab. You must have the Logon page in focus to change passwords. 

 

Figure – SM_137 
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Helpful Hints (continued) 

7. (J) From the Action drop-down menu choose Reset Password. 

 

Figure – SM_138 

8. (K) Complete the mandatory fields and (L) click OK. 

   

 

   

 

 

 

 

 

 Figure – SM_139 
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Reviewing Referral & Cases for Quality Control  

Referral Review 

Before approving a Determine Response request in a referral, review the Screener Narrative document and the Open Notebook dialog 

box that appears when you click the Open Existing Allegation icon. 

If the decision is "Evaluate Out", review the Response Guidelines in the Determine Response dialog box that appears when you select 

the Determine Response command in the Action menu. 

If you need additional information, open the Emergency Response Referral document. 

Before approving a Client Disposition request in a referral, start with the Investigation Narrative document. 

If you need additional information, generate a Referral Profile Report and/or a Delivered Services Log report. 

Placement Review 

Before approving a Placement start by generating a Client Summary report then the History of Child Placements report. 

If you have concerns about the child’s special needs, open the child’s Health and Education Passport document. 

If you have concerns about the ability of the substitute care provider to meet the child’s special needs, review the Placement Home 

notebook (e.g., the Characteristics page) and/or generate a History of Placements in the Home report. 

Case Plan Review  

Before approving a Case Plan, review the case plan document in hard copy before the staff person sends it to you electronically to 

approve. Do this for two reasons: 

You can read faster from paper than from a monitor. 

Case plans are read-only while they have an approval status of "Pending Approval". 
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Reviewing Referral & Cases for Quality Control (Continued) 

If it is a case plan update, review the Objectives page in the Case Plan notebook for the case plan that is in effect. 

 

Court Review 

Before approving a Court report review the court report document in hard copy before the staff person sends it to you electronically to 

approve. Do this for two reasons: 

You can read faster from paper than from a monitor. 

Court reports are read-only while they have an approval status of "Pending Approval". 

If you need additional information, generate the Court Order Summary and/or Legal Status History reports. 

End Case Review 

Before approving a request to End Case, review the Closure Statement on the Closure Summary page of the Case Information 

notebook, and review the Reminders notebook. 

Review the Objectives page in the Case Plan notebook for the case plan that is in effect, and generate a Delivered Services Log report 

for the last 60 days. 

Finally, click on the “Start Navigational Tools” icon (or access this function from the Tools menu) and select the Federal Reporting 

Navigation Tool. 
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Reviewing a Case Plan for Quality Control 

Case plans created and updated in the CWS/CMS application include an assessment of the case situation and an appraisal of service 

needs, as well as a goal, objectives to be achieved, specific services to be provided, and case management activities to be performed. 

The case plan is the guiding principle in the provision of child welfare services (see Welfare and Institutions Code, Section 16501(a)), 

and the California Department of Social Services Manual of Policies and Procedures contains detailed regulations for completing an 

assessment and creating a case plan. 

Review the case plan for approval when it is created and updated, and review it for progress toward the objectives at any time while 

the case plan is in effect. 

To verify a case plan was completed within the 60 days of the first in person contact with the child. Click on the Open Existing Case 

Plan icon, and, in the Open Notebook dialog box, compare the Start Date for the case and the Effective Date for the initial case plan. 

When a case is created from a referral, the case Start Date automatically populates with the date of the first in person contact with the 

child. The Effective Date for a case plan is the date the supervisor approved it. 

Look at the Objectives page in the Case Plan notebook to see if the case plan has measurable, time-limited objectives. You will see 

each objective along with additional description information - for each case plan participant. 
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Reviewing a Case Plan for Quality Control (continued) 

Use the Case Plan Navigational tool. You will see each objective for each case plan participant - but not the additional description 

information. 

 

Figure – SM_140 
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Reviewing a Case Plan for Quality Control Visitation (continued) 

To verify visits between the child and his/her parent(s), guardian(s) and or siblings have been arranged, look for rows with "Arrange 

Visitation" as the Service Type on the Case Management Services page of the Case Plan. 

To see if visits are occurring as arranged in the case plan, generate a Delivered Service Log report selecting only "Visits" in the 

Delivered Service Select Filter. 
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Figure – SM_141 

Reviewing a Case Plan for Quality Control Parental Review (continued) 

Look in the Participant Review group box on the ID page of the Case Plan notebook to verify parent(s) signed the case plan document. 

  
 
Figure – SM_142 

 

To verify services are being provided and case management activities are being performed in order to meet the case plan objectives, 

first, look at the services and case management activities that have been included in the case plan. You can do this by: 

Looking on the Planned Client Services and Case Management Services pages in the Case Plan notebook in the in effect case plan - 

where you will also see description details for each service and activity, or Using the Case Plan Navigation tool (but, you will not see 

the description details for the services and activities). 
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Then, generate a Delivered Service log report selecting only "Services" in the Delivered Service Select Filter. 

Reviewing a Case Plan for Quality Control Concurrent Planning (continued) 

To verify concurrent planning requirements have been met in the case plan, first look at the Case Plan Participants page in the Case 

Plan notebook. Note the Permanency Alternative/Concurrent Planning field. Go to the Case Management Services page in the Case 

Plan notebook, and look for services to support the permanency alternative. They will have "Concurrent Services Planning" as the 

Service Type. 
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Figure – SM_143 

Reviewing a Case Plan for Quality Control (continued) 

A Case Plan notebook can be attached to a court report by bringing the Court Report notebook into focus and using the Attach existing 

Case Plan command in the Attach/Detach menu. This action identifies/links the case plan that was in effect when a review hearing was 

held. (Note: it does not merge the court report and case plan.) 
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If this has been done, you can Open the Court Report notebook, select the Open Associated Case Plan Documents command in the 

Associated menu, and see which case plan was in effect when the court report was created. 
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Reviewing Health and Education Information for Quality Control 

In order to verify documentation for a child’s health and education information, open the child's Health and Education Passport 

document located in the Client Management section (blue button), Document notebook. 

If you just want to know if the information is on file, look at the Demographics page of the child's Client notebook, scroll down to the 

Health Grid and the Education Grid. 

 

Figure – SM_144                                                                 Figure – SM_145                                                       
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Reviewing Health and Education Information for Quality Control (continued) 

Reviewing Medical Information  

Medical information is entered in the Health notebook. However, some medical information (e.g. for children in out-of-home care) is 

entered in associated services in the CWS/CMS application. The case record must contain all available health reports regarding the 

child (see MPP 31-075). To verify if an individualized health care plan has been created for a child with special health care needs in 

out-of-home care, open the Health notebook, and look at the Individual Health Care Plan on File for Special Needs Child check box 

on the Summary page. 
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Reviewing Health and Education Information for Quality Control (continued) 

For details, review the pages in the Health notebook or look at the Health and Education Passport (HEP) document. 

 

Figure – SM_146                                                                                           

 

                                                                            Figure – SM_147   
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Reviewing Health and Education Information for Quality Control (continued) 

To see if the child has received medical and dental examinations through the CHDP Program (or equivalent preventive health 

services) in accordance with the CHDP Program schedule for periodic health assessment, click the Reminder icon in the Case 

Management section (green button), and look for "CHDP Dental Exam Due" and "CHDP Medical/Dental Exam Due" reminders. 

    

Figure – SM_148 
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Reviewing Health and Education Information for Quality Control (continued) 

Open the child’s health notebook, in the Client Management section (blue button) and look at the Well Child page in the Open 

Existing Health notebook. 

 

Figure – SM_149 
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Reviewing Health and Education Information for Quality Control (continued)  

To see if the child's available medical history was given to the child's substitute care provider (SCP) in a timely manner, open the 

Placement notebook, and look at the Date SCP Given HEP and Informed of Purpose field on the bottom of the ID page. 

 

 Figure – SM_150 
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Reviewing Education Information for Quality Control 

To verify all education information for a child has been recorded, open the Education Notebook and review the Grade Level 

Information page. 

 

Figure – SM_151 
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Reviewing Transitional Independent Living Plan for Quality Control 

To view the Transitional Independent Living Plan (TILP), (A) click on the TILP notebook, (B) From the Transition Plan page you can 

view current and historical data .To verify the TILP document has been created (C) click on the Open Existing Document notebook. If 

there is a TILP listed, and you want to review it, you can open it from the dialog box. 

  
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 Figure – SM_152 
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Reviewing Contact for Quality Control 

Contacts between staff persons and a variety of types of participants (e.g., clients, service providers, and substitute care providers) are 

recorded in active referrals and cases. Services (e.g., counseling and crisis intervention), as well as visits (e.g., between a 

parent/guardian and a child) associated with contacts can also be recorded in referrals and cases. 

Child Welfare Service program regulations require that certain contacts made by staff persons, services provided and arranged by staff 

persons, and visits arranged for by staff persons be documented in referrals and cases in a timely manner. 

Contacts can be recorded in referrals and cases at any time while they are active. Contacts can be read in referrals and cases whether 

they are open or closed. 
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Reviewing Contact for Quality Control (continued) 

To verify the initial in person response and the investigation were completed within the required time frames, look at the Summary 

page of the Referral Information notebook. Note the Received Date field, Status group box, and Contact Information group box.  

 
 
Figure – SM_153 
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Reviewing Contact for Quality Control (continued) 

For additional information: 

Generate the Delivered Service Log report, selecting only "Contacts" in the Delivered Service Select Filter dialog box. Look at the 

Investigation Narrative document in the document notebook of the Referral Information notebook. 

  

 Figure – SM_154 
 
                                                                                            Figure – SM_155 
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Civil Rights Pamphlet 

To verify parents received a copy of the Civil Rights pamphlet, look at the Child Removal Info page in the Placement Management 

Section (red button) of the application. 

 

Figure – SM_156 
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Quality Assurance in a Case 

To verify if in-person Staff Person/Child, Staff Person/Parent-Guardian, and Staff Person/Substitute Care Provider contacts were made 

in accordance with the contact schedules in the case plan, look at the contact schedules entered on the Case Management Services 

page of the in effect Case Plan notebook (or use the Case Plan navigation tool). 

Click the Open Existing Contacts icon, click the History button in the Open Contacts dialog box, and select the date range you want. 

When the contacts you want are in cache, click the Filter button, select "Contacts" only, select the contact participant(s) you want in 

the Participants Name field menu, and click the OK button. 

Or, you can generate a Delivered Services Log report, using the filters that appear in the dialog boxes. 

To see if contact exceptions have been documented, open the in effect Case Plan notebook, and look at the Contact Exceptions field 

on the Case Management Services page. 

To see what efforts were made to locate an absent parent, open the client's notebook, and look on the Search Log page. 

If there is court involvement, a Declaration of Due Diligence report may have been created. Click the Open Existing Document-Court 

Icon in the Case Management section. If there is a Declaration of Due Diligence document, select it and click the OK button. 
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Preventative Tools  

Hidden Text in Court Reports 

Hidden text is blue characters in a court report template that are formatted so they can be shown or hidden. They do not print (unless 

you want them to) and do not affect formatting. 

Hidden text provides prompts and guidelines regarding content to be included in specific sections of the reports 

Use hidden text when creating court documents. 

Hidden text is created in system (master) templates. It is created at the CWS/CMS Project Office. Users can’t create or change the 

hidden text in the master templates. 

It is based on statutory and regulatory requirements and good social work practice. 
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Preventative Tools (continued) 

To view hidden text  

Create or open an existing Court Report document in a referral or case. If the hidden text is not displayed, click on the Office Button 

icon in Word, select Word Options at the bottom right of the dropdown menu. In the Word Options dialog click on Display in the left 

column and then check the Hidden text option under ‘Always show these formatting marks on the screen’. Click OK. Any hidden text 

will now show up in Word 2007. 

 
 
Figure – SM_157 
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Preventative Tools (continued) 

County Documents – Templates and County Specific Reports 

 

Creating county templates is covered in the CWS/CMS Resource Management class. 

You can open all document templates created by all counties. 

Because they are Microsoft Word documents, you could change a document, e.g., change the county name, and use it. Your county 

could also modify another county’s document, then save the changed document as one of your own county documents.  

 

Figure – SM_158 
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Preventative Tools (continued) 

County-specific reports are located in the Client Services application, click on the File menu and select the Print Reports command. 

Then, in the Generate New Documents dialog box, choose County-specific Reports as the Area of Interest. 

After you know what a report is used for, create the report in a referral or case and use the Print Preview button to open and look at it 

(noting how your data populates into it). 

If the report says what you want it to say, use the features of Microsoft Word to make the necessary changes, e.g., the county name, 

and print it. 

 

Figure – SM_159 
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Preventative Tools (continued) 

Responsibilities Description 

The role and responsibilities of a staff person with a secondary or read-only assignment to a referral or case can be entered on the 

Assignment page in the Referral Information and Case Information notebooks. It can also be entered using the Make Assignment 

command in the Action menu in the Caseload application. The Responsibility Description tells the staff person what task(s) is 

expected to perform in a referral or case. 

The Responsibility Description also populates to the Summary page in the Caseload notebook in the Caseload application. So, at a 

glance, a supervisor, as well as the staff person with the primary assignment, can see what tasks a staff person with a secondary 

assignment is expected to perform in a referral or case. 

Enter a Responsibility Description when you create a secondary assignment, including read-only responsibility. 
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Preventative Tools (continued) 

You can enter up to 160 characters in the Responsibility Description section, and the entire text will populate to the Summary page in 

the Caseload notebook. You cannot change the Responsibility Description. It becomes read-only when it has been saved to the 

database. However, if responsibilities change, you can end date the secondary assignment and create a new one. 

 
 
Figure – SM_160 
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Preventative Tools (continued) 

Information entered on the Assignment page, of the Client notebook, automatically populates to this page. 

 
 
Figure – SM_161 
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Concurrent Tools: User (Supervisor) Created Reminders 

A user-defined reminder is a description of a task to be performed by a specific date in connection with a referral or case. Unlike a 

system generated reminder, it must be created (attached to) a referral or case by a user. 

A user-defined reminder can be described by the creator in considerable detail (approximately 8,000 characters) in the Notes section 

of the Reminder notebook. So, a supervisor can enter casework-related expectations directly into the electronic referral or case. 

User-defined reminders can be attached (created) as long as a referral or case is open. 

To create a Reminder in a referral or a case, open the referral or case, and click on the “+” under the Open Existing Reminder icon. 

Enter a date, and type in the reminder – keeping in mind that only the first approximately 50 characters (eight to 10 words) you type in 

the Notes section will display in the Reminder Message in the Open notebook dialog box. 

 
 
Figure – SM_162 
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Concurrent Tools: User (Supervisor) Created Reminders (continued) 

A user-created reminder can easily be removed after the expectation has been met (task has been accomplished). It can just as easily 

be removed even if the expectation has not been met. 

To put the same Reminder in more than one referral or case, open the other referral or case. 

Click on the Attach/Detach menu, and select the Attach Existing Reminder command. 

The Attach Existing Reminder dialog box lists all user-defined reminders for the referrals and cases in current work that are not 

already attached to the referral or case in focus. Select the one you want, then click OK to close this dialog box and attach the 

reminder(s) you selected. 

Supervisors should expect staff persons to check the reminders in their caseload when they first logon each day. Using the Select-

Filter Reminders dialog box will help them manage their time effectively and efficiently. 

Expect staff persons to view the reminders in each referral and case that they open before entering any data. 
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Concurrent Tools: Documenting Deputy Director Reviews and Approvals 

The Further Approval Needed By field becomes active when Pending Further Approval is selected in the Approval dialog box. The 

field can be populated with the name of any staff person who has Supervisor authority in the office of the staff person who has 

primary assignment to the referral or case. 

State regulations require county deputy director approval for certain exceptions, e.g., parent-child visitation less frequently than once 

each month in a voluntary placement (MPP 31-340.212), and, in some counties, policy requires a staff person other than the Unit 

Supervisor approve certain staff requests. 

Select Pending Further Approval when you are not authorized to approve the request. 

The staff person authorized to give the higher approval, e.g., a county deputy director, must be set up as a Unit Supervisor in the 

Resource Management application.  

A higher approval request can’t be forwarded to a person in another office. 

The person authorized to give higher approval must have Officewide Read/Write privilege, and would have to access referrals and 

cases by using the Search and Open Associated Referral and Case functions. 

 

Figure – SM_163
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Corrective Tools: Electronic Audit Trail 

 
For most fields on notebook pages, the CWS/CMS application keeps track of the name of the first user who entered data in the field 

and the date it was entered.  The application also keeps track of the name of the person who most recently changed the data in that 

field and the date it was changed. 

 Sometimes this data entry history is displayed, e.g., in the Allegation notebook, and often it can be displayed using the View 

Audit command. 

 Data entry history supports accountability, and can help troubleshoot problems, e.g., an apparent violation of a CWS/CMS 

business rule. 

 View data entry history in an open or closed referral or case when you want to know the name of the first and/or last user to 

enter data in a specific field, and/or the date the data was entered. 

 The Allegation Conclusion History section in the Allegation notebook displays the following changes: 

 Name of the staff person who changed the allegation conclusion. 

 The Approval History section in the Approval Detail dialog box contains the name of the staff persons who requested and took 

action on approvals. 

 Both can include the reason for the change (in the Conclusion Description section and Rationale section respectively). 
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Corrective Tools: Electronic Audit Trail (continued) 

Changes that are displayable: 

 The View Audit command in the Edit menu usually enables you to see the name of the staff person(s) who made the first and 

last entry in most fields, and when they did it. 

 Some changes cannot be displayed, but they may be able to be identified in the database by CWS/CMS Project staff. 

     

       

       Figure – SM_164 
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Corrective Tools:  Federal Reporting Navigation Tool 

A navigation tool is a programmed assistant that guides you through the steps for performing a task and/or the choices about how 

something will be created. 

The Federal Reporting Navigation Tool takes you to the places where case-specific data required by Federal Regulations can be 

viewed or entered. 

Run the Federal Reporting Navigation Tool at anytime while the referral or case is active. It is most helpful when used at least once 

during each semi-annual reporting period a referral or case is open. 

The Federal Reporting Navigation Tool for NYTD checks data that states are required by Federal Regulations to collect on all current 

and former foster care youth who receive Independent Living Program (ILP) services and 17 year olds who are in foster care with 

follow up data after they age out. 

The Federal Reporting Navigation Tool for AFCARS checks data that states are required by Federal Regulations to collect on children 

in foster care and adopted children and send semi-annually to the Department of Health and Human Services (DHHS) data, e.g., age, 

reason for removal, and placement home type. 

The Federal Reporting Navigation Tool for AD42R checks data that states are required by Federal Regulations to collect on children 

who have been adopted. 

To run the Federal Reporting Navigation Tool, open the referral or case you want to review, and click on the Tools icon. 

In the Tools Menu – Client Services dialog box, select the Federal Reporting Navigation Tool, and click on the OK button. 

In the Federal Reporting Navigation Tool choose AFCARS, NYTD, or AD42R radio buttons. 

If choosing AFCARS radio button, click on the This Case button, then choose whether you want to review Foster Care, Adoption or 

All fields (data elements). 

If choosing NYTD or AD42R radio button, click on the This Case button. 
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Corrective Tools:  Federal Reporting Navigation Tool (continued) 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
Figure – SM_165 
 
 
 
 
 
 
 
 
 
                                                        
 
 
 
 
 
 
 

Figure – SM_166 

 

Figure – SM_167 
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Corrective Tools:  Case Plan Navigation Tool 

A navigation tool is a programmed assistant that guides you through the steps for performing a task and/or the choices about how 

something will be created. 

The Case Plan Navigation Tool guides you through the steps for and choices about how an initial or updated case plan will be created. 

It also enables you to view and update the key case plan elements (e.g., goal and objectives for each participant.). 

Use the Case Plan Review feature whenever there is an In Progress or In Effect Case Plan in a case. 

The Case Plan Navigation Tool displays case plan identifying data, e.g., case status and service component, as well as data elements 

required by regulations, e.g., projected goal completion date and appropriateness description. 
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Corrective Tools:  Case Plan Navigation Tool (continued) 

Open the referral or case you want to review, and click on the Tools icon. 

In the Tools Menu – Client Services dialog box, select the Case Plan Navigation Tool, and click on the OK button. 

In the Case Plan Navigation Tool dialog box, click on the In This Case button, then click on the Review button. 

 
 

 
Figure – SM_168 
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Program Management Reports 

Program Management Reports compile information at the statewide or county level from the CWS/CMS database. They are generated 

at the state, county, office, unit and caseload levels. 

Program Management Reports provide state and county child welfare services management with the information needed to monitor 

and evaluate the accomplishment of child welfare services tasks and goals (see WIC 16501.5). 

Program Management Reports are created on a fixed schedule according to the report frequency, and can be viewed at any time. The 

extract files for many of the reports are saved at the database, so users can select past as well as current reports. 

 

Approximately 86 Program Management Reports are available in seven areas of interest: 

 Case 

 Court 

 Intake 

 FCIS 

 Licensing 

 Placement 

 General Host 

 

The Licensing reports and the General Host report are in the Resources Management application. You can access them by using the 

Print Report command in the File drop-down menu. 

All other reports are in both the Client Services application and the Caseload application. You can access them by using the Print 

Report command in the File drop-down menu. 
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Program Management Reports (continued) 

To create reports  

 
 
Figure – SM_169 

 

You must have certain authorities and privileges to generate Program Management Reports. 

California Department of Social Services (CDSS) users with any level of authority who have Program Management Report privilege 

can access all program management reports on a statewide and county basis. 

 

County users with any level of authority and Program Management Report privilege can access all Program Management Reports for 

their county. All the data on the Program Management Reports comes from the CWS/CMS Database. 
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Program Management Reports (continued) 

Program Management Reports 

Each field on each report is defined, i.e.; it is mapped to a field in a CWS/CMS notebook. So, data in the Program Management 

Reports will be accurate and complete only if information has been entered accurately and completely in the right place in the right 

notebook. 

Local Reports 

A Local Report is a summary of information specific to a single referral, case, caseload or placement home. 

Use Local Reports to help with caseload management and quality control (e.g., Caseload Court Calendar and Contacts/Visits Schedule 

for Caseload); create hardcopy documentation (e.g., Delivered Services Log and Notice of Action); and aide in decision-making (e.g., 

History of Child Placements and History of Placements in a Home). 

Local Reports can be created on demand. They summarize the information in the database at the time the report is generated, and are 

not saved by the system Local Reports are grouped by Area of Interest, e.g., Adoptions, Client, Placement Home, and Services. 

 

 

 
Figure – SM_170 
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Program Management Reports (continued) 

Caseload Reports 

Caseload Report Descriptions 

Caseload Court Calendar Report 

This report presents all scheduled hearings for the selected caseload, including the name of the child calendared, service component, 

child’s juvenile court case number, child’s case identification number, hearing type, subtype and description, hearing date and time, 

court name, court location, and the social worker’s name.  This report provides the social worker and/or supervisor with a schedule of 

court hearing that have been set but not heard, for a specified period of time. 

Caseload Reminder Report 

This report contains data on work due for a selected caseload, grouped by case.  It also lists the case reminders for a caseload, 

essentially duplicating the online reminders for a case.  This report is generated on demand by workers and supervisors and applies to 

cases only (not referrals). 

Caseload/Family Listing and Reminder 

This report presents demographic data about each child with an open case who is assigned to a specific social worker’s caseload, 

including the child’s mother’s name and address, program information, and the due date of the next case plan update. 

Contacts/Visits Schedule for Caseload 

This report presents dates of all visits and contacts scheduled for a specific caseload. 



 

Rev: 01/2018           Supervisor/Manager Student 
Guide 

172  

Program Management Reports (continued) 

Unit Court Calendar Report 

This report provides a supervisor with a calendar of all future scheduled court hearing for a specific assignment unit and for a specific 

period of time.  It provides the supervisor with a schedule of all hearings set but not yet heard, for a specific period of time and 

functions as a hard copy calendar for the supervisor.  It includes the name of the focus child, service component, the child’s Juvenile 

Court Case Number, the child’s Case Identification Number, hearing type, hearing subtype, and description. 
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Summary 

This module provided an overview of the Supervisor/Manager responsibilities.  It introduced the follow topics: 

 Creating a Staff Person 

 Creating an Assignment 

 Reassigning a Caseload 

 Approvals in Cases and Referrals 

 Recording DOJ Grievance Procedures 

 Creating Secondary Assignment 

 Safety Alert 

 Suspending a Case 

 Helpful Hints 

 Quality Assurance in CWS/CMS 

 Concurrent Tools 

 Corrective Tools 

 Creating Reports 

 


